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THANK YOU FOR CHOOSING ROSS VIDEO

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.
Our mission is to:
1. Provide a Superior Customer Experience
« offer the best product quality and support
2. Make Cool Practical Technology
» develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and
empowers our employees. | hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to
us at solutions@rossvideo.com.

'D.-Q 2“5

David Ross
CEO, Ross Video
david.ross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a
special group. Our employees truly care about doing a great job and delivering a high quality customer
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our
behavior:

1. We will always act in our customers’ best interest.
We will do our best to understand our customers’ requirements.
We will not ship crap.

We will be great to work with.

A

We will do something extra for our customers, as an apology, when something big goes wrong and
it's our fault.

We will keep our promises.
We will treat the competition with respect.
We will cooperate with and help other friendly companies.

© o No

We will go above and beyond in times of crisis. If there's no one to authorize the required action in
times of company or customer crisis - do what you know in your heart is right. (You may rent
helicopters if necessary.)

About this Guide

* Ross Part Number: 7800DR-004-12.5
* Release Date: July 10, 2025. Printed in Canada.

e Software Issue: 12.5

The information contained in this Guide is subject to change without notice or obligation.



Copyright

© 2014 - 2025 Ross Video Limited. Ross® and any related marks are trademarks or registered trademarks of Ross
Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and
PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior
written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross
Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting
from the use of the information contained herein.

Patents

Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886;
7,914,332; 8307284, 2039277, 1237518; 1127289 and other patents pending.

Warranty and Repair Policy

Ross Video Limited (Ross) warrants its Streamline Pro Server systems to be free from defects under normal use and
service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis,
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose,
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard
warranty period by one year increments. For more information about an extended warranty for your Streamline Pro
Server system, contact your regional sales manager.



Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional
waste administration. You can also contact Ross Video for more information on the environmental performances of
our products.

Use of Hazardous Substances in Electrical and Electronic
Products (China RoHS)

Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http:// www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
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Company Address

Ross Video Limited

8 John Street
Iroquois, Ontario
Canada, KOE 1KO0

General Business Office:

Fax:

Technical Support:

After Hours Emergency:

Email (Technical Support):
Email (General Information):
Website:

Ross Video Incorporated

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

(+1) 613.652.4886
(+1) 613.652.4425

(+1) 613.652.4886
(+1) 613.349.0006

techsupport@rossvideo.com
solutions@rossvideo.com

http://www.rossvideo.com
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Introduction

A Word of Thanks

Thank you for choosing Streamline Pro as your Ross Video media asset management solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life
of your investment. Our sales team is more than happy to provide further information on the plans available.
Members of our sales team will promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Streamline Pro media asset management solution from Ross Video. We are
confident of your future pleasure with your choice.

Yours Sincerely,

VA

Peter Abecassis
Director of Product Management - Production Workflow
peter.abecassis@rossvideo.com
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About This Guide

This guide contains the following chapters that cover the use of the Streamline media asset management system:
1. Introduction — summarizes the guide and provides important terms, and conventions.

2. Getting Started — provides instructions on how to log into the Streamline Pro interface, summarizes the
interface, and how to personalize the layout of the plugin within your NRCS system.

3. Managing Assets — provides instructions on the ways to search and filter assets.

4. Supported Third Party Integrations — provides instructions on how to configure the Streamline Pro MOS
Plugin for third party NRCS systems, and for NLE systems.

5. Glossary of Terms — lists the hotkeys that you can use to quickly execute Streamline commands.

If you have questions pertaining to the operation of Streamline, please contact us at the numbers listed in the section
“Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.
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Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a

sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Assets panel, click Delete.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “User Role Configuration” in the Streamline Configuration Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a
step reads “File > Save As,” you would click the File menu and then click Save As.

Streamline Pro Streamline Pro User Guide (v12.5) Introduction * 1-3



Important Instructions
Star icons are used to identify important instructions or features. For example:

X After upgrading Streamline software, you must obtain feature licenses from Ross Video Technical Support
before users can access Streamline features.

Getting Help

The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the
product. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help
topics and User Guide:

¢ Contents — table of contents
* Index — keyword reference
¢ Search — full text search

» Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files on the Ross Video product Software
Installation DVD.

Contacting Technical Support

Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m.
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557
Toll free within North America: +1 844-652-0645

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our
North America location.

Our telephone number is: +44 (0)1189502446
International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America
center.
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Australia

Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: +1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America
center.

Online

E-mail: techsupport@rossvideo.com

Website: open a support request using the link http://www.rossvideo.com/support/tech-support.html to open a
support request.
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Getting Started

Streamline Pro is an award-winning asset management platform proven to arm some of the world’s top media
creatives with the best-in-class solutions to manage all their content. It is a comprehensive asset management
solution that allows you to organize, search, approve, collaborate, distribute and archive your digital media content.
The Streamline Xchange MAM enables you to quickly review, approve, and manage assets through a single web
client over the Internet - anywhere, anytime. When combined with the rest of the Ross suite of products, it
seamlessly integrates file-based workflows with signal-based infrastructures to offer single and multi-site

operations global access to their content and workflows.

It increases the value of every asset owned by your organization simply by increasing the use of it. Uploaded assets
are immediately accessible, searchable, and may be downloaded by users in any department. Simple and advanced

search tools provide the ability to find the right asset using any of the associated metadata.

This chapter discusses the following topics:

Streamline Pro Features

Streamline Ecosystem

Streamline Pro Workflow

Supported Media Formats

Starting Streamline Pro

Exploring the Streamline Pro User Interface

Panel Positions and Perspectives

Streamline Pro Streamline Pro User Guide (v12.5)
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Streamline Pro Features

Streamline Pro provides the following core features:

Q

Rapid Content Search

Easily locate and access content through an
efficient search and retrieval system,
streamlining the content management
process.

o

Accelerated Export Delivery

Quickly deliver exports to news rundowns,
optimizing the content distribution process
and meeting demanding deadlines.

-_

Seamless Content Integration

Effortlessly incorporate content into news
rundowns, improving the flow of the
content creation pipeline.

Automated Video Delivery

Streamline the transfer of assets to video
servers using automation, ensuring a
reliable and efficient content delivery
system.

2%

Simplified Adobe Collaboration

Enhance collaboration with content editors
using Adobe, fostering a more productive
and connected creative environment.

&

Trusted MOS Workflows

Benefit from proven Ross software tech-
nology stack to provide stable MOS work-
flows, guaranteeing a consistent and
dependable content management experi-
ence.

2-2 « Getting Started
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Streamline Ecosystem

The Streamline Pro solution combines the best of our current MAM capabilities in the Streamline Ecosystem into a
new single Streamline Pro interface. Streamline Pro is made up of an intuitive user interface that opens directly in
the Ross Inception News platform, or supported third party NRCS newsrooms, and provides content creation
integrations with Adobe Creative Cloud using the Streamline Xchange MAM.

Note: Different feature workflows are enabled depending on the solution purchased.

¢ Streamline Pro— Streamline Pro provides an end-to-end newsroom workflow that includes integrations with
Newsroom Computer Systems, Video Editors, Video Playout Servers and Automated Production Control.
Capabilities Include a HTML + MOS based extension for Inception along with file delivery to Video Servers.

> Requires Streamline Xchange MAM.
> Requires Inception (NRCS)
» Optional integration with Media I/O Video Server, OverDrive (APC) and Streamline Play.

* Streamline Xchange MAM — Streamline Xchange provides a centralized location for content creation
workflows, content tagging and long-term content archiving. Capabilities include remote editing with Adobe
Premiere along with access to live ingesting feeds from Media 1/O.

» Integrates with Streamline Pro.

For More Information on...
* Which Streamline solution is the best fit for your needs, reach out to a Ross Video Sales Representative.
* On related product documentation:

> Streamline User Guide

» Streamline Xchange User Guide
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Streamline Pro Workflow

Streamline Pro is a premium Media Asset Management (MAM) solution that streamlines your content creation and
live graphics workflows. Streamline Pro integrates seamlessly with the Ross ecosystem - leveraging workflows
with the Ross Video Inception newsroom system, Streamline Xchange (MAM), and Media I/O playout system.

The Streamline Pro MOS plugin simplifies the workflow for News directors, producers, graphics designers, video
editors, technical staff and archivists who use Ross Video’s Inception Newsroom as part of their day-to-day
activities. Once assets have been uploaded to the Streamline Xchange MAM, the assets are available for
consumption in your newsroom rundown stories via the plugin. The plugin allows you to easily search for assets,
add assets to stories in the Inception Newsroom control system, and preview assets, as shown in the workflow
diagram below.

Upload Assets to
Streamline Xchange

An asset is a container for a
file that is uploaded to the
Streamline Xchange system.
Each asset includes specific
metadata that identifies it
within the Streamline

s
Drag & Drop Assets

into a Rundown

Simply drag and drop your
selected assets into a
monitored rundown story in
your Ross Inception or
supported NRCS system.

ecosystem.
. J L J
. )
Search for Assets Preview Your
in Streamline Pro Assets
Search for assets in the Use the media player to
Streamline Pro plugin using preview your assets in
specific criteria and custom Streamline Pro.
filters. Filter to ensure that
only assets that meet your
preferred search criteria will
appear in the results.
J

Required Components

The following is a list of the required components for the Streamline Pro MOS workflow:
+ Streamline Pro (MOS Plugin)
* Streamline Xchange MAM

* Inception News (NCRS) v15 or later + compatible with OverDrive (APC)

Deployment Options

* On Premise:

> Streamline Xchange MAM Server
> Streamline Xchange MAM Web Client

» Shared Storage Device (such as Ross EVO Storage)

> Archive

¢ Remote or At Home:
> Remote MAM Web Client
> Remote Adobe Suite Clients

¢ Cloud Services:

> Cloud Archive

> Al Services

2—4 « Getting Started
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Optional Components
* XPression MOS Plugin
* Media I/O Video Server for Ingest and Playout

Minimum Hardware Requirements

Database Server

* Windows Server 2019 64-bit

* 32GB Memory

* Intel Xeon E-2144G 3.6GHz or higher
» 2x480GB SSD SATA 6Gbps

Media Processing Server

* Windows Server 2019 64-bit

* 64GB Memory

* Dual Intel Xeon Silver 4214 or higher
+ 2x480GB SSD SATA 6Gbps

For More Information on...
* The Streamline Xchange MAM Server, see the Streamline Xchange User Guide.

* The Inception Newsroom, see Inception User Guide.

Supported Media Formats

The following sections describe the media formats supported by the Streamline Pro system.

Thumbnail Viewing

Streamline Pro supports the following image formats for thumbnail viewing:
+ BMP

* GIF

« JPG

*+ PNG

« TGA

» TIF

+ WBMP

A PNG thumbnail is generated when Streamline Pro encounters one of the support formats. This thumbnail is
scaled down to fit within a 256x144 image.
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Video Playout

Streamline Pro supports video playout within your web browser using Flowplayer for the following formats:

Table 2.1 Supported Video Formats for Playout

Format Video Codec Audio Codec
F4v H.264 AAC
FLV Sorenson H.263 MP3
MP4 H.264 AAC

Metadata Collection

Streamline Pro supports the gathering of structural metadata using the Medialnfo tool. Refer to the Medialnfo

website for a list of analytics and supported file formats.

Starting Streamline Pro

A user can access Streamline Pro application in a supported web browser, or in Ross Video’s Inception News
computer system and social media management tool using the Streamline Pro MOS Plugin.

* To open Streamline Pro Individually (Web Browser)
* To open the Streamline Pro MOS Plugin in Inception

* To close Streamline Pro (Web Browser or Inception)

* To troubleshoot login issues

|— Inception News Application

Gocortin m=u D EBORWE BPMOA* O ®
e

To open Streamline Pro Individually (Web Browser)

— Streamline Pro Plugin

This method is only used by administrators for verification purposes. If the provided web page URL ends in
“.../pro/plugin” then it will open the Streamline Pro plugin individually in the browser.

Typically users will sign into the provided Inception web page directly, as shown in the procedure:

> “To open the Streamline Pro MOS Plugin in Inception”.

1. Use one of the following supported web browsers to open the Streamline Pro web page provided by your

administrator:
Note:

* Microsoft Edge™ v112 or greater
* Google Chrome™ version 51 or greater

2-6 * Getting Started
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* Mozilla Firefox® version 52 or greater

* Apple Safari® version 10.2 or greater

The Streamline Pro Pro Log in panel opens.

> Stesmline Pro x o+

< C A Notsecure | 10.64.181.204/pro/plugin o

0%
*
»

Copyright Ross Video 2023

2. Inthe Log in panel, enter your Streamline Pro login credentials in the Username and Password fields
3. Click Log in.

Streamline Pro opens.

* If an error message indicates that the server cannot be reached, a system administrator must establish a database
connection before you can log in as a Streamline Pro user. For a list of possible error messages and
recommendations, see “To troubleshoot login issues” on page 2—8.

To open the Streamline Pro MOS Plugin in Inception

The procedure assumes you have already logged into Ross Video’s Inception News software application in a
supported web browser.

1. From the Inception News main toolbar, navigate to MOS Plugin and select Streamline Pro from the
dropdown menu.
Note: The name of the Streamline Pro plugin may vary based on your system administrator’s settings.
By default the Streamline Pro Plugin appears in the lower right position, as shown below:

Gcortion m=nB BEEORWS B LPROX © @
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2. Login to the Streamline Pro Plugin with the user credentials provided by your administrator.

Content Tools Help  Logout

Gocertion m=ull BEBORWé BPEMOA @ ®
B Disney [Archived) B
L e Do @ o Cotoserions | @) ticechien | Al rember | ¥ Reesn

lcon Page  Slug er e Submitted  Approved | Published Break Floated  Video

iy 10th story

£3uly 10th story

save | () A Deete Ocuss | 8 Crete Pacenoiser Recase org
@ = a S

B 7 U@ o £ tald H| & < Xchange - infemal test
»?)
as aa Aa[sor | |E|[ Global - || rrooucroncue. -

120_xchangelntemal

WordCount 0 | ReadWordCount:0 | SOTWe

0 Estimated Time: 00:0000 RO: Disney

Logged inas Adminsiator 4 <+ @

Figure 2.1 Displays the Streamline Pro Login Page

To close Streamline Pro (Web Browser or Inception)

1. On the main toolbar next to the B User icon, click the - dropdown menu.

2. Select Logout.
The active user is logged out, and the Log In dialog prompt reappears.

Note: If multiple versions of Streamline Pro are open in either Inception or the web-browser, the user will be
signed out of all clients.

To troubleshoot login issues

Common issues may include Streamline Pro user permission error (expired license or user limit reached), server
connectivity, or forgotten password. In most cases it is recommended that you contact your administrators with the
error details. See the examples below:

* Permission Error — If expired, contact your administrator if to renew your license.

» Expired License — If all licenses are already in use, contact your administrator to request additional
licenses.

* Server Connectivity issue — If the server is not reachable, notify your administrator and provide details of
the error message.

* Forgotten password — On the Streamline Pro login page, click the Reset Password button to change your
password.
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Exploring the Streamline Pro User Interface

Streamline Pro integrates seamlessly into the Inception Newsroom, and you have access to all your MAM content
within the platform. Once an Inception user is logged in, they can open the Streamline Pro plugin from the main

toolbar, by navigating to MOS Plugin and select Streamline Pro Plugin.

The Streamline Pro Plugin opens in a pane on the bottom right, as shown below, but can be moved to any panel
position by holding down your mouse on the upper menu bar:
Gocertion m=uil EBEO RS

M Disney [Archived] [l HOLD PB

£ s 1B e @ ® weroe B e 4 rox B o

lcon Page  Sug segment e chila  Coded Assignees Submitted Approved | Published Break Floated | Video

Juy 1oth story

2 x

ve | () ae | §Qoeee | ) @G ceepucenoer | AF Recase | g D >

Sl el
B
AA 33 Aa| sor | [E] | Global - | | PRODUCTIONCUE -
-

120_xchangeiniemal

WordCount 0 | ReadWord Count:0 | SOTWord Count:0 | Estimated Time: 00:00:00 RO: Disney

[T —— A 1)

For More Information on...
 configuring your workspace, see: ‘“Panel Positions and Perspectives”

+ adding an asset to the Streamline Pro system, refer to the section Streamline Xchange User Guide.

The Streamline Pro user interface consists of a main toolbar (to search for assets, filter by type, archive status,
category, approval status, editor, and location) and a search view that displays your results.

P Qsearchve

Asset Type

19u-

Archive Status

B VY clip 02 |8 cYening news election 01
05/16/2023 14:44:50 05/11/2023 11:11:08

2 "
RO Name [ vesther report 6282023 H terview_01 [ sadium backdrop 11
05/09/2023 16:12:21 05/09/2023 14:47:27 04/28/2023 09:37:31

Select filters © X s =
Editor G _—

Select filters

Select filters
Category

Select filters
Approval Status

Select filters

PV

Select filters . [ stadium backdrop_12 [ stadium_backdrop_13 8 plaver placeholder 01
04/26/2023 10:13:50 04/25/2023 17:36:06 04/2572023 17:35:29

L 1 #

50/62 Items

Location

Note: The icons that you access from the main toolbar depend on the features your organization purchased and the
user permissions that your Streamline Pro administrator assigned to your user account.
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Overview of the Main Toolbar

The main toolbar is located at the top of the Streamline Pro interface. The icons in the main toolbar enable you to
leverage all the MAM features of Streamline Pro. The icons that you access from the main toolbar depend on the
features your organization purchased and the user permissions that your Streamline Pro administrator has assigned

to your user account.

Plugin Name

(Provided by
| Admin)

Close Plugin
Add selected Open

Search Bar assets to an Online
| | Inception story Help |

Asset Type

e na w

® Streamline Pro (01)

o Add to Story

|— Blue highlight indicates selected filters

Figure 2.2 Main Toolbar

The main menu toolbar contains the following icons:

Table 2.2 Overview of the Main Toolbar Icons

Name
Search Bar

Add to Story
Button

Asset Type Filter
- Video

Asset Type Filter
- Audio

Asset Type Filter
- Image

Asset Type Filter
- Document

Asset Type Filter
- Project File

Overview of the Search View

Description

Use the search tool to find assets quickly. To run a search query,
simply enter the asset’s name or unique identifier and press enter.
For example, def21c40-1.

Click this button to add the selected asset to an Inception
Newsroom Story. It is only active when one or more assets is
selected in the Search View.

Select this filter to show video assets.

Select this filter to show audio assets.

Select this filter to show still images.

Select this filter to show documents.

Select this filter to show project files.

The Search View displays the assets that match your specified criteria and filter settings. It lists assets that have
been uploaded to the Streamline Xchange MAM in a table or tile layout, allowing you to quickly access individual
assets or search the Streamline Pro system for specific assets. The displayed search results are listed by date (from
oldest to current). From the Search View, you can drag and drop an asset into a monitored rundown story.
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A thumbnail represents the asset in the panel. If the asset is a still, a thumbnail of the image is displayed. If an image
is not available for the asset thumbnail, an icon containing the name of the file extension is displayed. If an asset
does not yet have an associated file, a placeholder icon indicating the asset type is displayed until a file is associated
with it.

Selectflters - (]

NY_clip 01
0571612023 14:52:14

o
i

Assets matching
the search &
filter criteria

50/62 tems

|— Number of Items Viewed

Figure 2.3 Search Results

The Search View displays the following information:
Table 2.3 Status Bar

Name Description
Items Viewed Where the first number indicates the number of assets that match
# / # Items the search criteria that have already been viewed.

Where the second number indicates the total number of assets
that match the search criteria that you have yet to scroll down to
view.
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Panel Positions and Perspectives

When Inception News is accessed from a desktop computer, the user interface layout consists of the main toolbar
plus eight panel positions. Each panel position can contain zero or more types of panels. The Streamline Pro plugin,
and any other MOS plugin, open in a single panel on the Inceptions News interface. If some positions are
unoccupied, Streamline Pro optimizes the layout by expanding open panels to fill all available space. By default,
Streamline Pro does not occupy all eight panel positions.

top
middle

bottom bottom bottom
left middle right

Figure 2.4 Arrangement of the Eight Panel Positions

A user perspective is a customized view of the Inception News user interface. It is creating a custom mapping of the
different panel types to your preferred positions in the layout. All users can create perspectives for their own use.
Administrators can also create global perspectives and make them available to other users.

* Panels may not always appear exactly where you expect. As you open and close panels, Inception Newsroom
adjusts the layout to optimize use of the available space. For example, if the current perspective includes an
Asset Editor panel in the right column and you use it to open only an Asset Editor panel, the Asset Editor panel
occupies all the available space. As you open more panel types, Streamline Pro adjusts the layout to conform
with the perspective.

Default Panel Positions

When you first use Inception News, it opens certain types of panels in certain panel positions by default. Streamline
Pro opens in the bottom right corner by default. Inception News continues to use the default layout until you move
a panel or open a saved perspective. If you revert your panel layout to the default panel layout, Inception also
reverts the columns displayed to the default columns.

 creating and managing perspectives, refer to the Inception User Guide.

Move a Panel from One Layout Position to Another

You can move panels between layout positions to customize the layout to suit your typical workflow.
To move a panel from one layout position to another

1. At the top of the panel you want to move, click and drag the panel’s name tab.

2. Drag the pointer over the layout guide to specify the position to which you want to move the panel.

As you drag the pointer over the layout guide, the current drop position for the panel turns yellow. Light gray
indicates unoccupied positions. Dark gray indicates occupied positions that can accept additional panels.

3. When the position to which you want to move the panel turns yellow, release the mouse button.
After you have arranged panels to your liking, you can save the layout as a perspective.

For More Information on...

» saving a layout as a perspective, refer to the Inception User Guide.
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Rearrange Panel Tabs Within a Layout Position

You can rearrange the order of panel tabs within a layout position to customize the layout to suit your typical
workflow.

To rearrange the order of panel tabs within a layout position
1. Click and drag the panel’s name tab within the tab row at the top of the layout position.

As you drag the pointer over the tab row, a dotted rectangle indicates the current drop position for the selected
panel tab. If the rectangle surrounds a tab name, the drop position is to the left of that tab.

2. When the dotted rectangle indicates the desired position, release the mouse button to drop the panel tab.

You can also move a panel to a different layout position by dragging and dropping the panel name tab into the
tab row of the destination panel. After you have arranged panel tabs to your liking, you can save the layout as a
perspective.

Navigating within Panels
This section describes how resize and close panels, and how to navigate within column-based panels.
To resize a panel

» Hover the mouse pointer over an edge or corner of the panel until the resizing icon displays, and then click and
drag the edge or corner.

* Streamline Pro does not save custom panel sizing as part of a perspective.
To close a panel

* Click the B Close icon in the top right corner of the panel.

If the layout position contains more than one open panel, only the current panel closes.

Navigating within Column-Based Panels

Column-based panels consist of horizontal rows, each of which represents an asset, or a work order. Each vertical
column contains one type of information about the rows.

The following panel types are column-based:

» Asset Approvals
* Assets

* Work Orders

» Reports
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The following table describes how to navigate within a column-based panel.

Table 2.4 Column-based Panel Navigation

Desired Effect Action to Perform
To move between cells Press the Arrow keys (Up, Down, Left, or Right).
Alternatively, to move horizontally, press Tab or Shift+Tab.
To select a row Click the row or press the Up and Down Arrow keys to navigate to the
row.

Yellow shading highlights the selected row.

To select a range of rows Click the first row in the selection range, and then Shift-click the last row
in the selection range.
The row selection includes the first selected row, the last selected row, and
all the rows between the two selected rows.

To select multiple rows Click the first row to select, and then CTRL-click additional rows to add
to the selected row.

To select all rows Click a row, and then press CTRL+A.
Streamline Pro selects all the rows in a panel.

To select a cell Click the cell, or navigate to it by pressing the Arrow keys (Up, Down,
Left, or Right) or Tab keys (Tab, Shift+Tab)

To replace all the text in a cell Select the cell, press the Space Bar, and then enter new contents using the
keyboard.

To edit the text in a cell Select the cell, press the Insert key, press the Left and Right Arrow keys

to position the cursor, and then insert new content using the keyboard.
Press the Delete key to delete individual characters.

To change the status of a check Select the cell, and then press the Space Bar to reverse the cell status.
box in the selected cell

To scroll horizontally Click and drag the horizontal scroll bar at the bottom of the panel.

To scroll vertically Roll the mouse wheel or click and drag the vertical scroll bar on the right
side of the panel.

To move a column Click and drag the column header to a new location in the panel.
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Managing Assets

Streamline Pro enables you to archive, manage, distribute, and analyze your digital media (assets). You can tag
assets with keywords, comments, and metadata to help organize your assets into meaningful categories. This
information is used in searches of the Streamline Pro system, and when creating report criteria.

This chapter discusses the following topics:

* Searching for Assets
* MOS Status Options
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Searching for Assets

Streamline Pro allows you to access multiple assets from within a single Inception News platform, or alternatively
via a supported NRCS newsroom interface — such as AP ENPS. You can use the Search Tool or Filter to streamline
your content workflow and keep track of your content.

* The assets you wish to use must already be uploaded in the Streamline Xchange MAM. If an asset is not
available, create a placeholder to upload the asset to in the Streamline Xchange MAM later.

* “To locate assets by unique identifier, name, or custom field”
* “To add an asset to a story via Drag and Drop”
» Alternate Method: “To add an asset to a news rundown Story via Add to Story button”

To locate assets by unique identifier, name, or custom field
1. In Inception News, navigate to the Streamline Pro plugin.
2. Go to the search bar and enter the name, unique identifier, or custom field.

Tip: If you have a large number of assets with similar names, it is recommended that you search by unique
identifier.

3. If you wish to search for a specific type of asset, use the filter buttons to select the asset type(s) of your choice
(video, audio, image, document or file).

4. Press enter on your keyboard.
The search results appear below.

5. Ifrequired, scroll down to view the full list of assets.
Tip: At the bottom of the page, the number of items that match your search criteria is displayed. The first
number indicates the number of assets that have loaded, and the second number indicates the total number
available. For example, if the page loads 25 assets out of 50, then the indicator would display 25/50 Items. As
you move through the content, the indicator will continue to update.

To add an asset to a story via Drag and Drop

This procedure explains how to add an asset in Streamline to a story in Inception News. You must follow the steps
in the previous chapter to open the Streamline Pro MOS plugin in Inception News before you begin.

For More Information on...

* Opening Streamline Pro in Inception, see “Starting Streamline Pro”.

3-2 » Managing Assets Streamline Pro Streamline Pro User Guide (v12.5)



1. Open your Inception News DRunning Order Manager panel and click ESettings.

”
a. Open the “ MOS Devices tab and add your Streamline Pro MOS device.

[_] Edit Running Order ?2 X
a:r:}} Attributes a MOS Devices | M Studios | 5| Template l‘ﬂi’fl Outputs
MOS Device Monitors
= Ross Streamline O “
0 Ross Streamline Pro
O
O
O
O
O
O
O
O
Cancel || OK |

b. Click OK to apply your changes.

2. To monitor your rundown, from the Inception menu click DRunning Order Manager and double-click on
the running order you wish to modify.

Goception m=n R ECORWé B PMOX @ @

The running order will open in a separate tab.
a. From the Running Order pane, in this example 6PM News, sclect a story.
b. To start MOS device monitoring of the devices selected for the selected story, click the Monitor

button.
This will sync your running order with the Streamline Xchange MAM.
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3. To open the story, double-click on it.

MediaTime _ TotalTime__Forvard
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The story opens in the Story Editor panel.

4. To add an asset from the Streamline Pro plugin to the story:

a. Ifrequired, open the Streamline Pro Plugin, from the Inception main toolbar under Tools > MOS
Plugin and selecting the Ross Streamline Pro device.
Help Logout
PEO~ @ &
g Favorites
- Object Browser

(2 Ross Streamiine Pro

b. Search for an asset in Streamline Pro, and press enter. Select the asset you wish to use.

o gliding
Select fileers M B3 G7202023 14750

roName

Select filiers

Select filiers

Select filiers

171 ltens

The asset card will turn blue to indicate it is selected.
Tip: To deselect an asset, simply click the asset again.

c. Drag the desired asset into the Story Editor’s MOS objects area or click the Add to Story button. You’ll
notice a blue highlight bar appears to indicate where the asset can be placed in the MOS object rundown

3-4 » Managing Assets Streamline Pro Streamline Pro User Guide (v12.5)



wooo0 w00

oo wow | o000

oo wooo | 00000

Iy Glding i
& e o seecfivers ]| (e
Grisena 144750

The placeholder status should indicate the status “UNFULFILLED PLACEHOLDER”, unless it has not been
indexed before - in which case it will say “INDEXING” . After the placeholder has been fulfilled in the
Streamline Xchange MAM the asset status should change from “NOT READY” to “READY”, as shown

below:
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You can see the status indicator as it changes from ‘Indexing’to ‘Ready’.

To add an asset to a news rundown Story via Add to Story button

This allows you to add an asset in Streamline Pro to a broadcast story in Inception News. This procedure assumes
that you have already added the Streamline Pro MOS plugin to your Ross Inception News.

1. Select the asset you wish to add to a story.
The asset card will change color to indicate it is selected.
Tip: You can click the asset again to de-select it.

2. Click the Add to Story button.

The placeholder status should indicate the status “UNFULFILLED PLACEHOLDER”, unless it has not been
indexed before - in which case it will say “INDEXING” . After the placeholder has been fulfilled in the
Streamline Xchange MAM the asset status should change from “NOT READY” to “READY”.

Tip: More details on the statuses can be found under “MOS Status Options” on page 3—6.

3. Once the asset is ready after indexing, the asset essence can be found in the default destination storage.
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MOS Status Options

The MOS object placeholders in broadcast stories can display the following status options:
> “UNFULFILLED PLACEHOLDER” — Displays when the placeholder has been created, but has not begun
indexing yet.

> “INDEXING” — Displays if the Running Order that the asset belongs to is monitored, and the asset has
never been indexed before. The asset indexes from the Streamline Xchange MAM to Streamline Pro.

» “READY” — Displays after an asset has been successfully linked and indexed.

> “FAILED_ INDEX” — Displays if the asset fails to index in the Streamline Xchange MAM, and
consequently is not ready.
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Streamline Pro Web Video Editor

Streamline Pro provides a lightweight and HTMLS5 web-friendly Video Editor that can be accessed from the
Streamline Xchange menu.

* NOTE: The Streamline Pro Web Video Editor requires the purchase of a Video Editor license. If it is not present
in your Streamline Xchange MAM top menu, contact your Streamline administrator.

This chapter discusses the following topics:

* Opening the Streamline Pro Editor
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Opening the Streamline Pro Editor

Streamline Pro allows you to perform lightweight edits from our Streamline Web Video Editor. You can use the
Media Browser, Media Browser Preview Player, Timeline Editor, and Timeline Editor Preview to perform edits on
the assets from the Streamline Xchange MAM.

* NOTE: If the Video Editor tab does not appear, contact your Streamline Pro administrator.

To open the Streamline Pro Editor
1. In the Streamline Xchange MAM user interface, expand the top menu and select Video Editor.

TIP: Alternatively, open the Streamline Pro Web Video Editor using the URL address provided by your
Streamline Pro administrator.

streamlirfe‘) > Xplore W e  Upload  System Monitor  Project Dashboard | Video Editor | Logout
(change

The Streamline Pro Video Editor opens in a new tab.

For More Information on...
» Using the Video Editor, see the Streamline Pro Web Video Editor User Guide.
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Supported Third Party Integrations

Streamline Pro enables you to use our plugin with supported third party integrations. Currently these include
supported newsroom control systems (NRCS) and Non-Linear Editors (NLE). This chapter includes basic setup
information for administrators and client side configuration.

* NOTE: Streamline Pro NLE Plugin features may vary from the Streamline Pro Plugin that is sold with Inception
Newsroom or our supported NRCS MOS Plugin.

This chapter discusses the following topics:

* “Third Party Newsroom Control Systems (NRCS)”
* “Third Party Non-Linear Editors (NLE)”
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Third Party Newsroom Control Systems (NRCS)

Streamline Pro allows you to access multiple assets from within a single Inception News platform, or via a
supported NRCS newsroom interface — such as AP ENPS. Instructions for supported NRCS systems are listed
below.

NOTE: The procedures below assume that the required software for Streamline Pro (such as Streamline Xchange
and the Media I/O Workflow Server are already installed) and only include details on how to add the Streamline Pro
Plugin to the third-party system. Please refer to the Streamline Pro Release Notes for supported versions, upgrade
path information, and special notices not included in the manuals.

+ “AP ENPS NRCS Setup”
> “Configure the AP ENPS Primary Server”
» “Configure the AP ENPS Client”

AP ENPS NRCS Setup

AP ENPS newsroom supports the Streamline Pro MOS Plugin. An AP ENPS administrator must run through the
steps below to add a new MOS device to the AP ENPS newsroom on the primary server, and then configure the
Client workspace. This will allow users to access the Streamline Pro MOS plugin.

* IMPORTANT:
Before you begin, ensure that Streamline Xchange and Media I/O Workflow Server are both running.

Version compatibility:
AP ENPS v7.1 + earlier are not supported, see the Release Notes for Streamline Pro compatibility and special
upgrade path notices.

You must complete the steps below to access the Streamline Pro Plugin in the AP ENPS interface:

* “Configure the AP ENPS Primary Server”
e “Configure the AP ENPS Client”

Configure the AP ENPS Primary Server
To Create a User with Administrator Credentials
1. Login to the ENPS Primary Server with your credentials:

¢ Username: <Administrator or Root username>

o Password: *¥****kx

2. From your Windows Desktop, go to the "B N PS System Maintenance shortcut and open it.
3. Inthe AP System Maintenance dialog, from the left menu go to Settings > Staff.

4. Select Click here to add new row and fill in the required details for a new user with administrative
permissions, as shown in the example below:
+ ID — (AKENNEDY)
* Program — SYSTEM
* Active — Enable
* Supervisor — Enable
* Surname — <last name of user>
* Given name — <first name of user>
* ServerManager — Enable
* Snapfeed — no

* Maintain Tags — no
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5. Select ‘Save'

To Add a New MOS Device

1. Loginto ENPS Primary Server with your admin credentials:

¢ Username: <Administrator or Root username>

o Password:; *¥¥*kxkk

2. From your Windows Desktop, go to "N LN PS System Maintenance and open it.
The AP System Maintenance dialog opens.

3. From the Settings menu on the left, select MOS Configuration.

4. Select Click here to add new row, and add the following details:

Address — Enter MOS ID here.
Description — Enter MOS ID here.

IP/Endpoint — Enter the IP address or hostname. If the system is using SSL you must use
hostname.

ActiveX — ENPSHTMLHost
Program — System

Default settings — URL=http://XX.XX.XX.XXX:XXXX/pro/plugin (Enter the URL provided for your
Streamline Pro Plugin.)

MOS Version — Enter the MOS version. In this example, version 2. 8. 4.

Local DragDrop — On

Auto-Create: Enable

Story Send: Enable

RO Limit: 0

Object Type: VIDEO

Detached ActiveX: ENPSHTMLHost

Detached Default settings: URL=http://xx.xx.xx.xxx:xxxx/pro/plugin (Enter the pro plugin URL)
Color: Automatically selected (No need to change anything here)

Browser type: Chromium

5. Select 'Save'.

* IMPORTANT:
When you add a new MOS device, there may be a delay before it appears in the AP ENPS Client - MOS devices
list. It is always recommended that you close the AP Client and then re-open it to apply the changes.

* TIP:

If the MOS device does not show up after a suitable waiting period, you can do the following to trigger a reset:

a. On the ENPS primary server in the Windows search field, type CMD to open the Command Prompt
application, and select Run as an administrator.

b. Run “iisreset.exe”.

c. Close and re-open the AP ENPS Client on your computer system, and verify that the Streamline Pro MOS
Plugin now appears under the MOS Device List.
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Configure the AP ENPS Client
To Verify that the MOS Device is Accessible

After creating the user account on the AP ENPS Primary server, you can download and install the AP ENPS
Client.

1. To download and install the AP ENPS Client:

a. Open a browser, and go to the client URL, where the x is the port number, and the # is the ENPS version:
\\XX.XX.XX.XX \enps \v#\

b. Download and install Setup.exe.

2. After installing, double-click on the AP ENPS Client to open it.
The user will be logged in automatically

3. Double-click to launch the AP ENPS client.
The AP ENPS dialog opens.

4. Close the blue Alerts notification bar at the top.

. . d . .
5. From the bottom menu, right-click the *" Devices button and select the MOS device from the drop-down
menu.
The Streamline Pro plugin window opens in its’ own tab.

To Create a Running Order and Story

You will learn how to create a running order and story.

o
——

1. To access a list of existing running orders click the ***
and stories created in AP ENPS.

Browse button to display a list of all running orders

2. To create a new running order, navigate to the top menu go to **“ New >

New Rundown.
3. Fill in the details for the rundown under Basic Properties:

* RO name — Enter a meaningful name for the running order.
e Start Time —Select the start date and time for the rundown from the drop-down menu.
* End Time — Select the end date and time for the rundown from the drop-down menu.
e MOS Properties:

»  MOS Allow— Select your MOS Device.

* IMPORTANT:
Ensure that MOS Block is not selected.

¢ Select Save.

The RO appears under the Rundown tab.

4. To create a story, click & Insert Row.
The story name New Row 1 will appear as by default.
5. To edit the default name, click on it and enter the story slug that you wish to appear.

6. Now that your running order and story are saved, you can create a placeholder in the story following the
procedure below.
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To Add a Placeholder to a Story
Before you can add a placeholder to a story, you must add the following fields to your running order table headers:

* Object Placeholder Create
* Object Auto Create

« MOSID

* MOS Status

* MOS Object Slug

* MOS Story

1. To add any of the required fields, simply:
a. Click on the RO name.

b. Go to the Layout tab, and click E’ Select Columns.

c. Select the field from the list of Available fields, and use the > right arrow button to add it to the Selected
fields.

d. Once you’ve finished adding all of the required fields, click Save.
The RO layout will now display all of the required columns.

2. To create a placeholder, under the Object Placeholder Create column simply click on the story’s empty cell,
and enter the following details:

e MOS device — Select the Streamline Pro MOS device.

* Type — set the appropriate asset type. In this case, VIDEO.
* Slug — Enter a meaningful name for the placeholder.

* Click Save.

3. Select the cell under Object Autocreate, and select your Streamline Pro MOS device.
Now that the placeholder details have been added, the column details should appear:

* NOTE: Placeholders will only appear in Streamline Xchange and Streamline Pro after the running order has
been monitored. Follow the procedure below to monitor a running order.

To Monitor a Running Order (RO)
Once a story with a placeholder has been created, you can follow the steps below to monitor a running order.

1. Select the running order you wish to monitor, and go to the Production tab.

o
2. Select the *@MOS Story Send option.
* NOTE: This button must be selected before the MOS Control Active button is selected.

3. Select your Streamline Pro MOS device from the dropdown, and select Save.

&
4. From the Production tab, with your story selected, select ** MOS Control Active to monitor the running
order.
The story will now display an orange highlight to indicate it is monitored.

5. To verify that your running order is successfully monitored, go to Streamline Xchange and locate the project
with the same name as the running order. You should see the placeholder you just created in the project in
Streamline Xchange.
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Third Party Non-Linear Editors (NLE)

You can view the list of Non-Linear Editors (NLE) that the Streamline Pro Plugin supports below.

* “Edius X Pro Setup”
> “Configure the Edius X Pro Application”

Edius X Pro Setup

Edius X Pro video editor supports the Streamline Pro NLE Plugin. An administrator must run through the steps
below to add a new NLE device to the Edius X Pro video editor, and then configure the client workspace. This will
allow users to access the Streamline Pro NLE plugin from within the Edius X Pro user interface.

* IMPORTANT:
Before you begin, ensure that Streamline Xchange and Workflow Server are both running.

Configure the Edius X Pro Application
1. Unzip the provided build file, and confirm that you have the following three files:

¢ StreamlineProPlugin.exe
¢ StreamlineProConfig.txt
¢ StreamlineProMenultem.tpi
¢ StreamlineProExporter.tpi
2. Move each of the files to the directory location listed below:
* StreamlineProPlugin.exe — C: \Program Files\Streamline Pro\Edius\
* StreamlineProConfig.txt — C: \Program Files\Streamline Pro\Edius\
e StreamlineProMenultem.tpi — C:\Program Files\Grass Valley\EDIUS X\PlugIn\
* StreamlineProExporter.tpi — C: \Program Files\Grass Valley\EDIUS X\PlugIn\

3. To configure your Streamline Pro Plugin settings, open the streamlineProConfig.txt file, and locate the line
that says ‘[StreamlineProURL]’. Create a new line immediately under it with the desired Streamline Pro
host. For example, https://srvottawa0l:8443. where the suffix is the Local Area Network port number.

4. Add orupdate a new line for ‘ [ExportPresets]’ and add a line underneath for the default presets you wish
to use. The presets should follow the syntax below:
‘[ExportPresets]’
{ "<Preset 1 Name>": {"preset":"<preset information>", "extension":"<expected extension>"} }

See the following example:
[StreamlineProUrl]

https://srvottawa01:8443
[ExportPresets]

{"H.264":{"preset":"H.264/AVC MP4 1920x1080 29.97p
8bit","extension":"mp4"},"XDCAM": {"preset":"MPEG2 1920x1080 50Mbps CBR","extension":"mxf"}}

5. To save the file, go to File and select Save.

6. Launch the Edius application, and go to Tools > Streamline Pro plugin to verify that the plugin appears
successfully.
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Glossary of Terms

A

Asset — a metadata container for content. An asset can have a single file associated which is called the essence. An
asset without an essence is called a placeholder.

APC — this acronym stands for Automated Production Control, and in this document it is used to describe the Ross
Video OverDrive (APC) system.

D

Default File Storage — the file storage used to store asset essences when a user does not select a file storage when
they upload a media file to Streamline Pro.

Derived File — a file crated from another file, for example: scaled images, thumbnails, low res video proxy files,
or formats created by a transcoder.

E

Essence — the primary file associated with an asset. An essence can have a thumbnail and proxy as previews for
the associated Asset.

F

File — a single file stored on a Streamline Pro Server. A file can have one or more file locations, but only one file
location can be the Primary file location. The first file location in which the file is stored becomes the initial
Primary file location for the file. A file with no file locations is invalid and will be deleted from the Streamline Pro
Server.

File Location — an instance of a single file in a file storage. Properties of the file, like path and name, must match
the rules defined for the file storage.

File Storage — an extension of a file system that contains file locations for files. A file storage can be configured
with rules to control the behavior of file locations in the file storage, for example: naming rules, pathing rules, and
ingest validation.

File System — a defined location used to store files, for example: a local hard drive, cloud storage, FTP servers, or
any other device that can be used to store data.

Format — a file derived from the original file that is considered interchangeable with the original. A format
derived from the asset essence can be used in place of the Essence when pushing to file storages with incompatible
ingest validation.

Fulfill — the process of storing a file in a placeholder asset. The file used to fulfill a placeholder becomes the
essence of the asset.

Indexed File Storage — a file storage that the Streamline Pro Server monitors to discover files which the server
has not yet ingested. Indexed files are ingested into the Streamline Pro Server to create new assets.

Ingest — the process of uploading a file into a Streamline Pro Server, usually to create an asset. Ingest can also
refer to storing an existing file into another file storage.
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Ingest Trigger — a defined event configured for a file storage to trigger a push to the file storage. Mirror is an
example of an ingest trigger that will push to a file storage when a file location is stored on another file storage.

Ingest Validation — a condition that must be met for a file to be stored on a file storage. For example, the Require
Asset Approval condition only allows files on the file storage where the associated Asset is approved.

M

Mapping Profile — a combination of metadata pairs from two different objects that are used to set data from one
side of the pair to the other. For example: with an asset and file object pair, Streamline Pro uses metadata from the
file to set the metadata for the asset associated with the file.

Metadata — a set of data that provides information for another piece of data.

MOS 4 — MOS 4 is the latest update to the industry standard communication protocol between newsroom devices
and control systems. MOS 4 allows for direct and secure communication between OverDrive and NRCS systems
located on different networks or in the cloud. This allows for more flexibility and reduced complexity when moving
parts of your newsroom infrastructure off-site or to public or private cloud data-centers.

N

Naming Rule — a rule applied to the file name of file locations when a file is stored in a file storage. One or more
naming rules can be configured for a file storage and are applied in sequential order. Example naming rules would
set name casing or maximum length.

NRCS — this acronym stands for News Room Control System, and in this document it is used to describe the Ross
Video Inception (NRCS) system.

P

Pathing Rule — a rule applied to the folder path of a file location when a file is stored in a file storage. One or
more pathing rules can be configured for a file storage and are applied in sequential order. The resulting
combination of all pathing rules are appended to the root of the file system set and will be the physical placement of
the File Location.

Placeholder — an asset that does not contain an essence. Placeholders are typically used to hold metadata for a
future file that will become the asset essence. Ingesting a file into a placeholder fulfills the asset.

Primary File Location — a special file location that cannot be deleted until all other locations of a file have been
deleted, or the entire file or associated asset has been deleted. The Primary file location can be changed to another
file location of the same file at any time.

Proxy — a preview for a video file. A typical proxy for a video file is a low-resolution version of the original file
that can be played in a web browser.

Push — the process of sending a file to another file storage to create a new file location.

T

Task — an operation running in the background on the Streamline Pro Server.

Thumbnail — an image that represents a file. A typical thumbnail for an image is scaled down version of the
original file.
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W

Watch Folder — a configured location in a file system to watch for new files to ingest into the Streamline Pro
Server. In contrast to a file storage, files are not kept in a watch folder for storage but are only used to discover new
files to ingest into permanent storage.
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